Product Information

This document applies to IBM Cognos Analytics version 11.0.0 and may also apply to subsequent releases.

Copyright

Licensed Materials - Property of IBM

© Copyright IBM Corp. 2012, 2018.

US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.

IBM, the IBM logo and ibm.com are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at "Copyright and trademark information" at www.ibm.com/legal/copytrade.shtml.

The following terms are trademarks or registered trademarks of other companies:

• Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States, and/or other countries.

• Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.

• Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States and other countries.

• Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

• UNIX is a registered trademark of The Open Group in the United States and other countries.

• Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.

Microsoft product screen shot(s) used with permission from Microsoft.


US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
## Contents

**Introduction**................................................................................................................................. V

**Chapter 1. Components and tools used by IBM Cognos Dynamic Cubes**........................................ 1  
Server components ................................................................................................................................... 1  
Client-based interfaces ........................................................................................................................... 1  
Application tier components ................................................................................................................ 2  
Data tier: Content Manager .................................................................................................................... 2  
Modeling components ............................................................................................................................. 3  
Other components .................................................................................................................................... 3

**Chapter 2. Preparing to install IBM Cognos Dynamic Cubes**.............................................................. 5  
Review the Release Notes ........................................................................................................................ 5  
Review supported environments .............................................................................................................. 5  
Verify system requirements for Cognos Dynamic Cubes ......................................................................... 5

**Chapter 3. Installing and configuring IBM Cognos Dynamic Cubes**................................................... 7  
Installation checklist for using the IBM Cognos Dynamic Cubes software ........................................... 7  
Installing Cognos Cube Designer .......................................................................................................... 7  
Enabling the 64-bit Version of Report Server.......................................................................................... 8  
Setting up connectivity to relational databases ...................................................................................... 8  
Db2............................................................................................................................................................ 8  
Oracle....................................................................................................................................................... 9  
Netezza.................................................................................................................................................... 10  
NCR Teradata........................................................................................................................................... 10  
SQL Server............................................................................................................................................. 10  
Configure Cube Designer for SSL ........................................................................................................ 11  
Testing the installation of IBM Cognos Cube Designer ......................................................................... 12

**Chapter 4. Uninstalling IBM Cognos Cube Designer**.......................................................................... 13

**Chapter 5. Install and configure Dynamic Query Analyzer**............................................................. 15  
Supported environments ........................................................................................................................ 15  
Configure Dynamic Query Analyzer..................................................................................................... 15  
Install Dynamic Query Analyzer ........................................................................................................ 15  
Update your Java environment on Linux operating systems .................................................................. 15  
Creating a virtual directory to access log files ....................................................................................... 16  
Start IBM Cognos Configuration ........................................................................................................ 16  
Connect to IBM Cognos Analytics server ............................................................................................. 17  
Viewing data from another version ....................................................................................................... 17  
Start Dynamic Query Analyzer .......................................................................................................... 17

**Chapter 6. Setting up the samples for IBM Cognos Dynamic Cubes**................................................... 19  
Deploying sample dynamic cubes ......................................................................................................... 19

**Appendix A. Accessibility features**................................................................................................ 21  
Keyboard shortcuts for the Installation Wizard ....................................................................................... 21

**Index**.................................................................................................................................................. 23
Introduction

This document is intended for use with IBM® Cognos® Dynamic Cubes. IBM Cognos Dynamic Cubes is used with IBM Cognos Analytics to provide business users and analysts with the ability to model dimensional metadata and to create dynamic cubes to use as data sources in the Content Manager.

Audience

This guide is intended for system administrators. To use this guide, you should have basic Microsoft Windows, UNIX, and Linux administration skills.

Finding information

To find product documentation on the web, including all translated documentation, access IBM Knowledge Center (http://www.ibm.com/support/knowledgecenter). Release Notes are published directly to IBM Knowledge Center and include links to the latest technotes and APARs.

You can also read PDF versions of the product online help files by clicking the PDF links at the top of each HTML page, or access the PDFs from the IBM Cognos product documentation web page (www.ibm.com/support/docview.wss?uid=swg27047187).

Accessibility Features

Accessibility features help users who have a physical disability, such as restricted mobility or limited vision, to use information technology products. This product has accessibility features. For information on these features, see accessibility.

IBM Cognos HTML documentation has accessibility features. PDF documents are supplemental and, as such, include no added accessibility features.

Forward-looking statements

This documentation describes the current functionality of the product. References to items that are not currently available may be included. No implication of any future availability should be inferred. Any such references are not a commitment, promise, or legal obligation to deliver any material, code, or functionality. The development, release, and timing of features or functionality remain at the sole discretion of IBM.

Samples disclaimer

The Sample Outdoors Company, Great Outdoors Company, GO Sales, any variation of the Sample Outdoors or Great Outdoors names, and Planning Sample depict fictitious business operations with sample data used to develop sample applications for IBM and IBM customers. These fictitious records include sample data for sales transactions, product distribution, finance, and human resources. Any resemblance to actual names, addresses, contact numbers, or transaction values is coincidental. Other sample files may contain fictional data manually or machine generated, factual data compiled from academic or public sources, or data used with permission of the copyright holder, for use as sample data to develop sample applications. Product names referenced may be the trademarks of their respective owners. Unauthorized duplication is prohibited.
Chapter 1. Components and tools used by IBM Cognos Dynamic Cubes

IBM Cognos Dynamic Cubes adds a relational OLAP component to the Dynamic Query Mode server to provide a multidimensional view of a relational data warehouse. You can then perform OLAP analysis by using the Cognos Dynamic Cubes server.

IBM Cognos Dynamic Cubes integrates easily into your existing infrastructure by using resources that are already in your environment. Some of these existing resources are required, such as a Java™ virtual machine, or other databases for the content store. The Administration Console is used to deploy and manage the cube data. The dynamic query mode (DQM) server runs the cube data, and studio applications use the data in reporting environments.

In addition, various tools, such as IBM Cognos Cube Designer, provide dynamic cube design and modeling capability. The IBM Cognos Dynamic Query Analyzer is used to analyze and optimize the data as necessary.

Cognos Dynamic Cubes Workflow
The workflow for IBM Cognos Dynamic Cubes consists of five major steps. Users, such as the system analyst administrator, modeler administrator, or report author use various tools to manage and administer these steps.

The following steps are included in the workflow:

• Analyzing the data
  Before installing IBM Cognos Dynamic Cubes, the modeler and relational database administrator determine whether the data is a good candidate for IBM Cognos Dynamic Cubes.

• Designing and modeling a dynamic cube
  The modeler creates a basic dynamic cube, adds features to satisfy the business requirements, and ensures that the cube is available to IBM Cognos Administration.

• Deploying and managing a dynamic cube
  After dynamic cubes are published to Content Manager, the Administrator handles the initial configuration and subsequent management within IBM Cognos Administration.

• Running reports by using dynamic cube data
  The report author uses the dynamic cube as a data source in reporting applications.

• Optimizing a dynamic cube
  To optimize individual cube performance, the administrator can monitor the metrics of the dynamic cubes, and change, if necessary, the cube configuration.

Server components
Server components provide the user interfaces for reporting and product configuration, including the server functionality for routing and processing user requests. Server components associated with IBM Cognos Dynamic Cubes are organized into the following functional groups: Interfaces, application tier components, and Content Manager components.

Client-based interfaces
The following client-based user interface is available for use with IBM Cognos Dynamic Cubes.
**IBM Dynamic Query Analyzer**

IBM Cognos Dynamic Query Analyzer is an Eclipse-based client user interface that provides graphical representations for the query logs produced by dynamic query mode queries. In addition, Cognos Dynamic Query Analyzer includes the Dynamic Cubes Aggregate Advisor, a tool that analyzes dynamic cubes and recommends cube aggregation, based on available cube definitions and optional query load, to improve query performance.

Aggregate Advisor can also analyze previously run IBM Cognos Analytics reports and suggest aggregates that correspond directly to these reports. For more information, see the *IBM Cognos Dynamic Query Analyzer User Guide*.

**Application Tier Components**

The IBM Cognos Analytics applications tier contains one or more Cognos Analytics servers. An Cognos Analytics server runs requests, such as reports, analyses, and queries, that are forwarded by a gateway. An IBM Cognos Analytics server also renders the IBM Cognos Administration and studio interfaces. Report authors use the dynamic cubes as data sources in reporting applications.

**Configuring and managing the product - IBM Cognos Configuration**

IBM Cognos Configuration is used to configure Cognos Analytics, and to start and stop its services.

**Publishing, managing, and viewing content - Cognos Analytics portal**

Cognos Analytics portal provides a single access point to the corporate data available for its products. It provides a single point of entry for querying, analyzing, and organizing data, and for creating reports, scorecards, and events. Users can run all their web-based Cognos Analytics applications through the portal. Other applications, and web addresses to other applications, can be integrated with the portal.

**Central administration - Manage and Administration Console**

Cognos Analytics has a Manage function that you can use to perform common administration tasks day to day. An option from the Manage menu opens the Administration Console, a central management interface that contains the administrative tasks for IBM Cognos Analytics. It provides easy access to the overall management of the IBM Cognos environment. Access to the administration functions depends on user’s permissions.

**Professional reporting**

Using the Reporting tool, report authors create, edit, and distribute a wide range of professional reports.

**Ad hoc querying and self-service reporting - Query Studio**

Using Query Studio, users with little or no training can quickly design, create and save reports to meet reporting needs not covered by the standard, professional reports created in Reporting.

**Data tier: Content Manager**

Content Manager is the IBM Cognos Analytics service that manages the storage of application data, including security, configuration data, models, report specifications, report outputs, and so on.

Content Manager is needed to publish packages, retrieve and store report specifications, manage scheduling information, and manage the Cognos namespace.

Content Manager stores information in a content store database.
Modeling components

Modeling components model data within data sources to structure and present data in a way that is meaningful to users.

Modeling components include the following tools:

Creating a business view of your data - Framework Manager

IBM Cognos Framework Manager is the modeling tool for creating and managing business-related metadata for use in IBM Cognos Analytics. Metadata is published for use by reporting tools as a package, providing a single, integrated business view of any number of heterogeneous data sources.

Framework Manager must be installed to a different location than Cognos Analytics.

Designing and preparing dynamic cubes - IBM Cognos Cube Designer

IBM Cognos Cube Designer is the modeling tool used to design dynamic, aggregate, and virtual cubes. Relational metadata is imported to use as the basis for dynamic cube design. Individual dynamic cubes are deployed as OLAP data sources to Content Manager in IBM Cognos Analytics.

To work with a deployed cube in the IBM Cognos studios, the modeler must also publish a Framework Manager package for it, configure the deployed cube for use as a data source by the Query Service, and start the cube.

Other components

In addition to the tools that are provided, IBM Cognos Dynamic Cubes requires the following components that are created by using other resources.

Content store

The content store is a relational database that contains data that Cognos Analytics needs to operate, such as report specifications, published models and packages that contain them; connection information for data sources; information about external namespaces and the Cognos namespace itself; information about scheduling and bursting reports, and so on.

When setting up your Cognos Analytics environment, set up the content store to use a supported database that can be secured and tuned for performance and stability. For more information, see the topic about deploying the entire content store in the IBM Cognos Analytics Administration and Security Guide.

Design models and log files are not stored in the content store.

The IBM Cognos service that uses the content store is named Content Manager.

Data sources

Data sources, also known as query databases, are relational databases, dimensional or OLAP cubes, files, or other physical data stores that can be accessed through Cognos Analytics. Application tier components use data source connections to access data sources.
Chapter 2. Preparing to install IBM Cognos Dynamic Cubes

Before you install IBM Cognos Dynamic Cubes, some preinstallation tasks are required to set up your environment. For example, ensure that you have adequate system resources available, and that IBM Cognos Analytics (BI) software is successfully installed.

Install IBM Cognos Analytics software first to ensure that the product works. This process involves the following tasks:

- Installing one instance of each of the required server components (gateway, Application Tier Components, and Content Manager)

After you set up your environment, initially complete only the required configuration tasks so that your installation successfully runs in your environment.

The simplest and quickest way to get your IBM Cognos product to run in your environment is to ensure that a basic installation works before you customize the configuration. For more information, see the IBM Cognos Analytics Installation and Configuration Guide.

Use the following checklist to guide you through the setup process:

- Review the Release Notes.
- Review supported environments.
- Verify system requirements.

After you complete these tasks, you can continue with installing IBM Cognos Cube Designer.

Review the Release Notes

Review the Release Notes before you install the product. The Release Notes contain late-breaking information, known issues, documentation updates, and deprecation notices.

The Release Notes are available from IBM Cognos Analytics Knowledge Center (www.ibm.com/support/knowledgecenter/SSEP7J_11.0.0/com.ibm.swg.ba.cognos.cbi.doc/welcome.html).

Review supported environments

To ensure that your product works properly, apply all minimum required operating system patches, and use only the supported versions of third-party software.

To review an up-to-date list of environments that are supported by IBM Cognos Analytics products, including information on operating systems, patches, browsers, web servers, directory servers, database servers, and application servers, see the IBM Software Product Compatibility Reports page (www.ibm.com/support/docview.wss?uid=swg27047186).

Verify system requirements for IBM Cognos Dynamic Cubes

Use the following tables to check the minimum hardware and software requirements to install and run IBM Cognos Dynamic Cubes. You might require additional resources, such as disk space.

Hardware requirements

The following table lists the hardware requirements and specifications for a single computer installation.
Table 1: Hardware requirements for a single computer installation

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAM</td>
<td>Minimum: 4 to 8 GB per processor</td>
</tr>
<tr>
<td>Disk space</td>
<td>A minimum of 2.5 GB of free space is required to install the software, and 1GB of free space on the drive that contains the temporary directory used by IBM Cognos components.</td>
</tr>
</tbody>
</table>

Software requirements

The following table lists the software requirements and specifications for a single computer installation.

Table 2: Software requirements for a single computer installation

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows</td>
</tr>
<tr>
<td></td>
<td>Linux</td>
</tr>
<tr>
<td>Java Runtime Environment (JRE) Libraries</td>
<td>On Windows a JRE is provided with the installation.</td>
</tr>
<tr>
<td>Database</td>
<td>The following relational data sources are supported:</td>
</tr>
<tr>
<td></td>
<td>• IBM DB2®</td>
</tr>
<tr>
<td></td>
<td>• Netezza®</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server</td>
</tr>
<tr>
<td></td>
<td>• NCR Teradata</td>
</tr>
<tr>
<td></td>
<td>• Oracle</td>
</tr>
<tr>
<td></td>
<td>For the relational data sources, the Dynamic Query Mode requires only that you copy a Type 4 JDBC driver to the appropriate location.</td>
</tr>
<tr>
<td>JDBC driver libraries</td>
<td>IBM DB2 Universal Database™ for Linux, UNIX, and Windows,</td>
</tr>
</tbody>
</table>

JDBC driver files

The following table lists the JDBC driver files for common database software.

Table 3: JDBC driver files for common database software

<table>
<thead>
<tr>
<th>Database software</th>
<th>Driver</th>
<th>Native system libraries</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM Db2 Universal Database for Linux, UNIX, and Windows</td>
<td>IBM Db2 Universal (Type 4)</td>
<td>None</td>
</tr>
<tr>
<td>IBM Db2 for z/OS®</td>
<td>IBM Db2 Universal (Type 4)</td>
<td>None</td>
</tr>
<tr>
<td>Oracle</td>
<td>Thin driver</td>
<td>None</td>
</tr>
<tr>
<td>Microsoft SQL Server 2005</td>
<td>Microsoft SQL Server 2005 JDBC driver 1.1</td>
<td>None</td>
</tr>
</tbody>
</table>
Chapter 3. Installing and configuring IBM Cognos Dynamic Cubes

Dynamic cubes are databases optimized to provide high speed query performance over large data sets of metadata for business intelligence reporting and analysis. The dynamic cubes provide high speed query performance by implementing the following features: using targeted caching (reducing how often queries are issued to the database); aggregate tables (providing levels of aggregation at a higher level than a basic fact table); and multi-pass SQL (improving the performance of retrieving data from the database when the cache is not sufficient).

To run the IBM Cognos Dynamic Cubes software, the IBM Cognos Analytics Application Server and IBM Dynamic Query Analyzer must be at version 11.0.0 and installed to the same location as other Cognos Analytics Application Tier components.

Installation checklist for using the IBM Cognos Dynamic Cubes software

IBM Cognos Dynamic Cubes is used to model dimensional metadata and to create dynamic cubes to use as data sources in the Content Manager. The software includes IBM Cognos Cube Designer for designing dynamic, aggregate, and virtual cubes.

To install the IBM Cognos Dynamic Cubes software, perform the following tasks:

• Upgrade or install IBM Cognos Analytics version 11.0.0 Server software on a Windows, UNIX, or Linux operating system.
• Install IBM Cognos Cube Designer.
• Upgrade or install version 11.0-.0 of IBM Cognos Dynamic Query Analyzer on a 32-bit or 64-bit computer where the IBM Cognos Analytics Application Tier components are currently installed.
• Enable the 64-bit version of Report Server.
• Configure data connectivity to relational data sources.
• Test the IBM Cognos Cube Designer installation from the Start menu or from Framework Manager software.

64-bit installations

The report server component, included with the Application Tier Components, is provided in both 32-bit and 64-bit versions. Selecting which version you use is done by using IBM Cognos Configuration after installation. By default, the report server component is set to use the 32-bit mode, even on a 64-bit computer. By using the 32-bit mode, you can run all reports, whereas by using the 64-bit mode, you can run only reports created for dynamic query mode for improved report performance.

For more information about configuring the 64-bit report server, see the IBM Cognos Analytics Installation and Configuration Guide.

Installing IBM Cognos Cube Designer

Procedure

1. Go to the location where the installation files were downloaded and extracted and then double-click the ca_dcubemodel_<platform>_<build>.exe file.
2. Select the language to use for the installation.
The language that you select determines the language of the user interface. All supported languages are installed. You can change the user interface to any of the installed languages after installation.

3. Accept the defaults on the Component Selection page.
4. Follow the directions in the installation wizard to copy the required files to your computer.
5. In the Finish page of the installation wizard, complete the following steps:
   a) If you want to see the log files, click View for the appropriate log file.
   b) If you want to see late-breaking information about the product, select the check box for IBM Cognos Release Notes
   c) Click Finish.

Enabling the 64-bit Version of Report Server

When you use a 64-bit installation of IBM Cognos Analytics and the dynamic query mode, you can use the 64-bit report server. This report server supports only reports created with the dynamic query mode and provides improved report performance.

In a 64-bit installation, the report server component is provided in both 32-bit and 64-bit versions. The default option is 32-bit.

Procedure
1. Start IBM Cognos Configuration.
2. In the Explorer panel, click Environment.
3. For the Report server execution mode, click the Value box and select 64-bit.
4. From the File menu, click Save.

Setting up connectivity to relational data sources for the dynamic query mode

For the relational data sources, the dynamic query mode requires access to only the Type 4 Java Database Connectivity (JDBC) drivers and their appropriate license files. The JDBC drivers provide an API that is vendor-independent. This independence allows IBM Cognos web applications to connect to different data sources and retrieve and update data using standard SQL statements. The network protocol used by a particular database converts the JDBC calls directly.

To allow the reporting engine to connect to supported relational databases by using dynamic query mode, you must first install the required Java Database Connectivity (JDBC) driver files. You then copy the Java Archive (.jar) file of the JDBC driver to the directory that is accessible to the web page that will invoke the applet.

After you copy the driver files for your data source, users can create dynamic cubes. For more information, see the "Dynamic cube modeling" chapter of the IBM Cognos Dynamic Cubes User Guide.

Setting up connectivity to Db2 data sources

To connect to Db2 data sources, the dynamic query mode requires access to the IBM Db2 type 4 JDBC driver and its appropriate license file.

About this task
Because Type 4 driver is an independent product, you are not required to install the Db2 software. That is, you are not required to install the Db2 client on the computer where you installed Content Manager.

For the Type 4 JDBC connectivity, you must copy the universal driver and the accompanying license file to your IBM Cognos installation location.
Procedure
1. On the Windows operating system, stop the Db2 services and the HTML Search Server.
2. In the IBM DB2 installation directory of the database that you want to use for the connection, locate the ..\SQLIB\JAVA directory.
3. Copy the following files to the cognos_analytics_server_install_location\drivers directory.
   - Universal driver file, db2jcc.jar
   - License files, based on the IBM Db2 platform
     - Db2 on Linux, UNIX, or Windows, db2jcc_license_cu.jar
     - Db2 on z/OS, db2jcc_license_cisuz.jar
4. On Windows, restart the Db2 services and the HTML Search Server.
5. Stop and then restart the IBM Cognos service.

What to do next
After you copy the driver files for your data source, users can create dynamic cubes. For more information, see the "Dynamic cube modeling" chapter of the IBM Cognos Dynamic Cubes User Guide.

Setting up connectivity to Oracle data sources
To connect to Oracle data sources, the IBM Cognos dynamic query mode can use the same Oracle JDBC driver to perform either Type 2 or Type 4 Oracle JDBC connections.

About this task
The type of Oracle JDBC driver depends on the version of Java used with the IBM Cognos Analytics installation.

Important: When using the dynamic query mode to perform a Type 2 Oracle JDBC connection, you must install the Oracle native libraries.

Procedure
1. On the computer where the Oracle client is installed, go to the ORACLE_HOME/jdbc/lib directory.
2. Locate and copy the following JDBC driver file, based on your Java version, to the cognos_analytics_server_install_location\drivers directory.

<table>
<thead>
<tr>
<th>Java version</th>
<th>JDBC driver file name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.5</td>
<td>ojdbc5.jar</td>
</tr>
<tr>
<td>1.6</td>
<td>ojdbc6.jar</td>
</tr>
</tbody>
</table>
3. Set the following required environment variable for your operating system.

<table>
<thead>
<tr>
<th>Platform</th>
<th>Oracle environment variable</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linux</td>
<td>LD_LIBRARY_PATH</td>
<td>the directory where the Oracle client ociJDBCXX library is installed, where XX is the version of Oracle</td>
</tr>
<tr>
<td>Microsoft Windows</td>
<td>PATH</td>
<td>the directory where the Oracle clientociJDBCXX library is installed, where XX is the version of Oracle</td>
</tr>
</tbody>
</table>
4. Locate the \cognos_analytics_server_install_location\v5dsserver\databaseDriverLocations.properties.sample file and rename it to databaseDriverLocations.properties.

5. In a text editor, open the renamed databaseDriverLocations.properties file.

6. Set the databaseJNIPath property to the directory that contains the ociJDBCxx library, where xx is the Oracle version.

7. Save the changes and close the file.

8. For changes to take effect, stop and restart the IBM Cognos service.

What to do next
After you copy the driver files for your data source, users can create dynamic cubes. For more information, see the "Dynamic cube modeling" chapter of the IBM Cognos Dynamic Cubes User Guide.

Setting up connectivity to Netezza data sources
The IBM Cognos dynamic query mode uses the Type 4 JDBC driver to connect to the Netezza databases. You must copy the Netezza JDBC driver file to the appropriate directory on the file system.

Procedure
1. Within the Netezza client installation directory, locate and copy the nzjdbc.jar file to the \cognos_analytics_server_install_location\drivers\directory.
2. For changes to take effect, stop and restart the IBM Cognos service.

What to do next
After you copy the driver files for your data source, users can create dynamic cubes. For more information, see the "Dynamic cube modeling" chapter of the IBM Cognos Dynamic Cubes User Guide.

Setting up connectivity to NCR Teradata data sources
To connect to NCR Teradata data sources, the IBM Cognos dynamic query mode uses the Type 4 JDBC driver for NCR Teradata and its required configuration file.

Procedure
1. Within the NCR Teradata installation directory of the database that is used for the connection, locate and copy the terajdbc4.jar and tdgssconfig.jar files.
2. Paste the files that you copied in step 1 to the \cognos_analytics_server_install_location\drivers\directory.
3. For changes to take effect, stop and restart the IBM Cognos service.

What to do next
After you copy the driver files for your data source, users can create dynamic cubes. For more information, see the "Dynamic cube modeling" chapter of the IBM Cognos Dynamic Cubes User Guide.

Setting up connectivity to Microsoft SQL Server data sources
To connect to Microsoft SQL Server data sources, the dynamic query mode requires that you copy the appropriate Java Archive (.jar) file of the JDBC driver to the directory that is accessible to the web page that will invoke the applet. The file that you copy is based on the data source security strategy.

Before you begin
To access data from a SQL Server database by using the Microsoft JDBC Driver for SQL Server, you must have the following components installed on your computer:

• Microsoft JDBC Driver for SQL Server
• Java Runtime Environment

About this task
The file requirements are dependent on the data source security strategy. For nonintegrated security connections that pass the saved signon information, the dynamic query mode requires access to only the Microsoft Type 4 JDBC driver. For integrated security connections that use the service credentials to connect to the data source, the dynamic query mode requires access to both the Microsoft Type 4 JDBC driver and its associated 32-bit or 64-bit authentication dynamic linked library (DLL). The following table lists the type of IBM Cognos Analytics data source authentication types and the files required to establish a successful connection.

<table>
<thead>
<tr>
<th>IBM Cognos authentication type</th>
<th>JDBC driver file name</th>
</tr>
</thead>
<tbody>
<tr>
<td>No authentication</td>
<td>sqljdbc4.jar</td>
</tr>
<tr>
<td>IBM Cognos software service credentials</td>
<td>sqljdbc4.jar</td>
</tr>
<tr>
<td></td>
<td>sqljdbc_auth.dll</td>
</tr>
<tr>
<td>An external namespace</td>
<td>sqljdbc4.jar</td>
</tr>
<tr>
<td></td>
<td>sqljdbc_auth.dll</td>
</tr>
<tr>
<td>The signons of this connection</td>
<td>sqljdbc4.jar</td>
</tr>
</tbody>
</table>

Use the following instructions to configure Microsoft SQL Server integrated security connectivity for use within IBM Cognos Analytics installed on a Windows operating system.

Procedure
1. Download and install the Microsoft SQL Server JDBC driver from the Microsoft website.
2. In the Microsoft SQL Server JDBC driver installation directory, locate and copy the sqljdbc4.jar file to the cognos_analytics_server_install_location\drivers directory.
3. In the Microsoft SQL Server JDBC driver installation directory, locate and copy the 32-bit or the 64-bit version of sqljdbc_auth.dll to the cognos_analytics_server_install_location\bin (or bin64) directory.
4. For changes to take effect, stop and restart the IBM Cognos service.

What to do next
After you copy the driver files for your data source, users can create dynamic cubes. For more information, see the "Dynamic cube modeling" chapter of the IBM Cognos Dynamic Cubes User Guide.

Configure Cube Designer for SSL
This topic explains the steps required to configure IBM Cognos Analytics Cube Designer for accessing a Secure Sockets Layer (SSL) enabled Cognos Analytics Gateway.

Procedure
1. Open a command prompt window with administrator privileges.
2. Navigate to cube_designer_install_location\jre\bin.
   For example, Program Files\ibm\cognos\dcubemodel\jre\bin.
3. Run the following command:

   ```keytool -import -storepass changeit -alias certificate_alias -file certificate_file_name```
Run this command for each certificate in the chain.

4. Restart Cube Designer and verify that access to the Cognos Analytics Gateway is working.

5. If you get warnings in Cognos Configuration, use the ThirdPartyCertificateTool to import the certificates into the CAMKeystore.

For more information, see Import the CA certificates into IBM Cognos components in IBM Cognos Analytics Installation and Configuration.

Testing the installation of IBM Cognos Cube Designer

You can test the installation of the IBM Cognos Cube Designer by verifying that the shortcut appears on the Start menu and it can be accessed from Framework Manager, if Framework Manager is installed.

Procedure

1. To test the installation from the Start menu, from the Windows Start menu, click Programs > IBM Cognos Cube Designer > IBM Cognos Cube Designer.

2. To test the installation from Framework Manager:
   a) Launch the Framework Manager software.
   b) From the Welcome page, choose to open a project or create one.
      - To open an existing project, click Open a project, browse to locate the project folder, select the .cpf file, and click Open.
      - To create a project, click Create a new project.
   c) From the Tools menu, click Run IBM Cognos Cube Designer.

Results

You can test Dynamic Cubes with your IBM Cognos Analytics application server by modeling a simple cube (one dimension, one hierarchy, and one measure), publishing it to a data source, and deploying it to a server. For more information, see the IBM Cognos Dynamic Cubes User Guide.
Chapter 4. Uninstalling IBM Cognos Cube Designer

Use the Uninstall wizard to remove the IBM Cognos Cube Designer software.

About this task
It is not necessary to back up the configuration and data files on a Microsoft Windows operating system. These files are preserved during the uninstallation.

Procedure
1. From the Start menu, click Programs, IBM Cognos Cube Designer, Uninstall IBM Cognos Cube Designer.
2. In the Uninstall wizard, select the language of the installation.
3. Continue following the prompts to complete the uninstallation.
   The cognos_uninst_log.htm file records the activities that the Uninstall wizard performs while uninstalling files.
   Tip: To find the log file, look in the Temp directory.

Results
Uninstalling does not remove any files that changed since the installation, such as configuration and user data files. Your installation location remains on your computer, and you retain these files until you delete them manually.
Chapter 5. Install and configure Dynamic Query Analyzer

Install Dynamic Query Analyzer from the installation wizard. After you install the product, use IBM Cognos Configuration to configure the product.

Supported environments

To ensure that your product works properly, apply all of the required operating system patches, and use only the supported versions of third-party software.

To review an up-to-date list of environments that are supported by IBM Cognos Analytics products, including information on operating systems, patches, browsers, web servers, directory servers, database servers, and application servers, see the IBM Software Product Compatibility Reports page (www.ibm.com/support/docview.wss?uid=swg27047186).

Unless otherwise indicated, IBM Cognos products are compatible with later versions of patches or service packs from the versions stated.

It is important to note that the Linux operating system is available in a number of distributions and supports a number of hardware platforms. Ensure that the combination of the operating system and hardware that you are using is supported.

Cognos products and virtualization environments

The IBM virtualization policy (www.ibm.com/software/support/virtualization_policy.html) describes IBM support for virtualization environments.

For more information, search supported server virtualization environments by product (pic.dhe.ibm.com/infocenter/prodguid/v1r0/clarity/vesForProduct.html).

Configure Dynamic Query Analyzer

Use IBM Cognos Configuration to configure Dynamic Query Analyzer. If you are using a Linux operating systems, you must ensure that you set the JAVA_HOME environment variable before you start IBM Cognos Configuration.

Install Dynamic Query Analyzer

Use the following steps to install Dynamic Query Analyzer.

Procedure

1. Go to the location where you downloaded and extracted the installation files, and choose the operating system directory, such as winx64h.
   - On Microsoft Windows operating systems, double-click the ca_dqa_<platform>_<build>.exe file.
   - On Linux operating systems, type ./ca_dqa_<platform>_<build>.
2. Follow the directions in the installation wizard.

Update your Java environment on Linux operating systems

For Linux operating systems, ensure that you set the JAVA_HOME environment variable before you start IBM Cognos Configuration.
Procedure
2. Ensure that you have, at minimum, the Java version indicated.
3. Set a JAVA_HOME environment variable to your installed version of Java.

Creating a virtual directory to access log files
If you do not install Dynamic Query Analyzer on the same computer as you install IBM Cognos Analytics server, you can create a virtual directory, or alias, to allow Dynamic Query Analyzer to read query log files and workflow log files.

If you are using Dynamic Query Analyzer only to run the Aggregate Advisor, you do not have to create the virtual directory.

Procedure
Create a virtual directory that is named DQLogs that refers to the <cognos_analytics_server_installation_location>/logs/XQE location on the IBM Cognos Analytics server.

- For Apache Web Server or IBM HTTP Server, the directory definition would look like the following example:

```
Alias /DQLogs "<cognos_analytics_server_installation_location>/logs/XQE"

<Directory "<cognos_analytics_server_installation_location>/logs/XQE">
    Order allow,deny
    Allow from all
    Options +Indexes
</Directory>
```

- For Microsoft Internet Information Services (IIS), you must enable the Allow double escaping option for the virtual directory properties.
  - In the Internet Information Services (IIS) Manager console, create the virtual directory.
  - Select the virtual directory, and double-click Directory Browsing.
  - Click Enable.
  - Select the virtual directory, and double-click Request Filtering.
  - Click Edit Feature Settings.
  - Enable Allow double escaping, and click OK.

Start IBM Cognos Configuration
Use IBM Cognos Configuration to configure Dynamic Query Analyzer.

Before you begin
On Linux operating systems, ensure that you update your Java environment before you start IBM Cognos Configuration.

Procedure
Do one of the following steps:
- On Microsoft Windows operating systems, from the Start menu, click Programs > IBM Cognos Dynamic Query Analyzer > IBM Cognos Configuration.
  - If you are using a Windows Vista, Windows 7, or Windows 2008 computer, and you have installed the product to the Program Files (x86) directory, start IBM Cognos Configuration as an Administrator.
On Linux operating systems, go to the `<installation_location>/bin64` directory and then type the following command:

```
./cogconfig.sh
```

If IBM Cognos Configuration does not open, ensure that you set the DISPLAY environment variable.

If you see a `JAVA.Lang.unsatisfied link` message, verify that you are using a supported version of Java.

If you see a `Java.lang.unsupportedClassVersionError` message, ensure that you are using a 64-bit version of Java.

**Connect to IBM Cognos Analytics server**

To configure Dynamic Query Analyzer, you must specify the location of the IBM Cognos Analytics gateway and a dispatcher for the server that contains the reports that you want to analyze.

**Procedure**

1. In IBM Cognos Configuration, in the Explorer window, click **Environment**.
2. Enter the **Gateway URI** and **Dispatcher URI for external applications** values for the IBM Cognos Analytics server.
3. Click **File > Save**.

**Viewing data from another version**

Dynamic Query Analyzer displays results from a workspace that is defined in the `DQA.ini` file. You can change the workspace by editing the `DQA.ini` file.

For example, if you have two versions of Dynamic Query Analyzer, each version refers to its own workspace. If you want to view results from another version, you can edit the `DQA.ini` file to refer to the workspace of your other version.

**Important:** Dynamic Query Analyzer can display results from one workspace at a time. Ensure that you change the `-data` path back to the original location when you want to view those results.

**Procedure**

1. Go to the `installation_location/dqa/os-version/eclipse/workspace` directory where you installed the new version of Dynamic Query Analyzer.
2. Open `DQA.ini` in a text editor.
3. Edit the `-data` path to point to the workspace of your previous version of Dynamic Query Analyzer.
4. Save and close the file.

**Start Dynamic Query Analyzer**

Before you start Dynamic Query Analyzer ensure that you save your configuration settings, and that the IBM Cognos server is running.

**Procedure**

1. Do one of the following steps:
   - On Microsoft Windows operating systems, from the **Start** menu, click **Programs > IBM Cognos Dynamic Query Analyzer > IBM Cognos Dynamic Query Analyzer**.
   - On Linux operating systems, go to the `<installation_location>/bin64` directory and then type the following command:

```
./dqa.sh
```
2. If you are using Dynamic Query Analyzer for query log file analysis, do the following steps.
   a) Click Window > Preferences > Logs.
   b) In the Logs directory URL box, enter the path to the virtual directory created in “Creating a virtual directory to access log files” on page 16.
   c) If the Logs directory URL link is secured, enter the required user name in the Name box and password in the Password box.
3. Test the configuration of Dynamic Query Analyzer.
   a) In Dynamic Query Analyzer, click Windows > Show View.
   b) In the Show View dialog box, click Navigation > Content Store, and click OK.
      If the configuration is correct, in the Content Store pane, the IBM Cognos content from the specified server displays.
Chapter 6. Setting up the samples for IBM Cognos Dynamic Cubes

You can use the sample data to learn how to design and model dynamic cubes and use the data in reporting environments.

The IBM Cognos Dynamic Cubes samples are based on the model.fmd sample database model. This model refers to the GOSALESDW database that contains sample data that other IBM Cognos products use. In Microsoft SQL Server, the dynamic cube uses the GOSALESDW database. In IBM Db2 and Oracle, the dynamic cube uses a single schema from the database.

The sample model is available in Samples\models\great_outdoors_dynamiccube.

Deploying sample dynamic cubes

To work with sample dynamic cubes in the IBM Cognos studios, use the IBM Cognos Cube Designer to deploy the sample dynamic cubes and make them available as data sources. The sample dynamic cubes are gosldw_sales, gosldw_target, and gosldw_sales_and_target.

Before you begin

The great_outdoors_warehouse data source connection must be set up before you deploy sample dynamic cubes.

If anonymous access is disabled, you must use the credentials that are associated with your account to publish cubes. Go to the Personal tab in the Set preferences dialog of the IBM Cognos Portal, and create your credentials before you proceed.

About this task

You do not have to publish a package to use the sample reports; the package is part of the sample deployment.

Procedure

1. From the Start menu, click Programs > IBM Cognos Cube Designer > IBM Cognos Cube Designer.
   Tip: You can also start the IBM Cognos Cube Designer from IBM Cognos Framework Manager. From the Tools menu, select Run IBM Cognos Cube Designer.
2. Open the project that contains the dynamic cube that you want to deploy and publish.
   a) From the toolbar, click Open.
   b) Navigate to the location where you downloaded the sample model and open model.fmd
3. In the Project Explorer tree, expand the project and model.
   Note: You may be prompted to log on to an IBM Cognos Analytics Server.
4. Right-click the gosldw_sales dynamic cube, and select Publish.
5. To deploy the dynamic cube and configure the cube as a data source, in the Publish window, expand Additional Options and select the Add the dynamic cube to the default dispatcher check box.
6. To start the dynamic cube, select the Start the dynamic cube check box.
7. If anonymous access is disabled, make sure the Associate my account and signon with the cube datasource check box is selected. For anonymous access, clear the check box.
8. Repeat steps 4 - 7 for the cube gosldw_target, and lastly for the virtual cube gosldw_sales_and_target.
9. Click OK.
Results
If the deployment and publish process is successful, no errors are reported. A message confirms that the cubes started successfully. You can now use the sample packages to create reports that rely on dynamic cube data sources. You can also run the sample reports that are available in Team content.
Appendix A. Accessibility features

Accessibility features help users who have a physical disability, such as restricted mobility or limited vision, to use information technology products.

See the IBM Accessibility Center (http://www.ibm.com/able) for more information about the commitment that IBM has to accessibility.

See the IBM Cognos Analytics Accessibility Guide for information about accessibility in Cognos Analytics.

Keyboard shortcuts for the Installation Wizard

Keyboard shortcuts, or shortcut keys, provide you with an easier and often faster method of navigating and using software.

The installation wizard uses standard Microsoft Windows operating system navigation keys in addition to application-specific keys.

Note: The following keyboard shortcuts are based on US standard keyboards.

The following table lists the keyboard shortcuts that you can use to perform some of the main tasks in the installation wizard on the Windows operating system.

Table 7: List of keyboard shortcuts on a Windows operating system

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the next field on a page</td>
<td>Tab</td>
</tr>
<tr>
<td>Return to the previous field on a page</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Close the installation wizard</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Move to the next configuration step</td>
<td>Alt+N</td>
</tr>
<tr>
<td>Return to the previous configuration step</td>
<td>Alt+B</td>
</tr>
<tr>
<td>Move to the next selection in a list</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Move to the previous selection in a list</td>
<td>Up arrow</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in the installation wizard on the UNIX or Linux operating system.

Table 8: List of keyboard shortcuts on a UNIX or Linux operating system

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the next field on a page</td>
<td>Tab</td>
</tr>
<tr>
<td>Return to the previous field on a page</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Close the installation wizard</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Move to the next selection in a list</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Move to the previous selection in a list</td>
<td>Up arrow</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in the License Agreement page of the installation wizard.
**Table 9: List of keyboard shortcuts on the License Agreement page**

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept the license agreement</td>
<td>Alt+A</td>
</tr>
<tr>
<td>Decline the license agreement</td>
<td>Alt+D</td>
</tr>
<tr>
<td>Quit the installation wizard</td>
<td>Alt+x</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in IBM Cognos Configuration on a Windows operating system.

**Table 10: List of keyboard shortcuts for IBM Cognos Configuration on a Windows operating system**

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save the current configuration</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Close IBM Cognos Configuration</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Rename the selected item</td>
<td>F2</td>
</tr>
<tr>
<td>Display the File menu</td>
<td>Alt+F</td>
</tr>
<tr>
<td>Display the Edit menu</td>
<td>Alt+E</td>
</tr>
<tr>
<td>Display the View menu</td>
<td>Alt+V</td>
</tr>
<tr>
<td>Display the Actions menu</td>
<td>Alt+A</td>
</tr>
<tr>
<td>Display the Help menu</td>
<td>Alt+H</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in IBM Cognos Configuration on a UNIX or Linux operating system.

**Table 11: List of keyboard shortcuts for IBM Cognos Configuration on a UNIX or Linux operating system**

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save the current configuration</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Close IBM Cognos Configuration</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Rename the selected item</td>
<td>F2</td>
</tr>
</tbody>
</table>
Index

Numerics
64-bit report server
  enabling for dynamic cubes 8

A
accessibility features 21
aggregate cubes
  using Cognos Cube Designer 3
application tier components 1
audience of document v

C
Cognos Analytics portal 2
cognos_uninst_log.htm file 13
components
  Cognos Analytics portal 2
  Content Manager 2
  content store 3
  data sources 3
  Framework Manager 3
  IBM Cognos Administration 2
  IBM Cognos Configuration 2
  Query Studio 2
  Reporting 2
configure Dynamic Query Analyzer 15
Content Manager
  component description 2
  content store
    component description 3

D
data sources
  component description 3
  DB2 connection 8
  NCR Teradata connection 10
  Netezza connection 10
  Oracle connection 9
  setting up connectivity 8
  SQL Server connection 10
data tier
  Content Manager 2
db2jcc_license_cisuz.jar file 8
db2jcc_license_cu.jar file 8
DLL files
  sqjdbc_auth.dll 10
dynamic cubes
  deploying sample data 19
  using Cognos Cube Designer 3
dynamic query mode
  setting up data source connections 8

E
environment variables
  Oracle 9

F
FMD files
  model.fmd 19
Framework Manager
  component description 3
  testing installation of Cognos Cube Designer 12
  uninstalling Cube Designer 13

G
gateway components 1
gosldw_sales sample dynamic cube 19
gosldw_sales_and_target sample dynamic cube 19
gosldw_target sample dynamic cube 19

H
hardware requirements 5
HTML files
  cognos_uninst_log.htm 13

I
IBM Cognos Administration
  component description 2
IBM Cognos Configuration
  component description 2
IBM Cognos Cube Designer
  deploying sample cube 19
  testing the installation 12
  uninstalling 13
IBM Cognos Dynamic Cubes
  components 1
IBM DB2
  setting up connection 8
install Dynamic Query Analyzer 15
installations
  hardware and system requirements 7
  testing IBM Cognos Cube Designer 12

J
JAR files
  db2jcc_license_cisuz.jar 8
  db2jcc_license_cu.jar 8
  nzjdbc.jar 10
  ojdbc5.jar 9
  ojdbc6.jar 9
  sqjdbc4.jar 10
tdgssconfig.jar 10
JAR files (continued)
  terajdbc4.jar 10
Java Database Connectivity (JDBC) client supported 5
Java on Linux operating systems 15
Java runtime environment (JRE) supported 5
JRE (Java runtime environment) supported 5

K
keyboard shortcuts 21

L
LD_LIBRARY_PATH (environment variable) 9

M
Microsoft SQL Server
  setting up connection 10
model.fmd file 19
modeling components 3

N
NCR Teradata
  setting up connection 10
Netezza
  setting up connection 10
nzjdbc.jar file 10

O
ojdbc5.jar file 9
ojdbc6.jar file 9
operating systems
  supported versions 5
Oracle
  setting up connection 9

P
PATH (environment variable) 9
products
  supported versions 5

Q
query databases 3
Query Studio
  component description 2

R
relational data sources
  connecting to 8
release notes
  reviewing 5
report server
  enabling 64-bit 8

S
samples
  database models for dynamic cubes 19
  deploying dynamic cubes 19
server components 1
shortcut keys 21
software
  uninstalling Cube Designer 13
software requirements
  supported product versions 5
sqljdbc_auth.dll file 10
sqljdbc4.jar file 10
SSL
  configure for Cube Designer 11
start Dynamic Query Analyzer 17
supported environments 5
system requirements 5

T
tdgssconfig.jar file 10
terajdbc4.jar file 10

V
virtual cubes
  using Cognos Cube Designer 3
virtual directory for BI server log files 16
virtualization
  supported environments 5